Cellpro 4s Gold Charger

Model LIPOCH4S04-GOLD, for use with LiPo, Li-lon
and A123 battery packs with node connectors

Automatic and manual charging at up to 4A with cell
balancing and overcharge protection

Features

Simple to operate: just connect the Cellpro 4s charger between a power source and a pack.
No jumpers, plugs or dials to set! Charger automatically determines pack capacity and sets
optimal current, then dynamically adjusts charge rate as needed. Manual charge rates of
0.25A to 4A (in 0.25A increments) allow for special situations.

m Charges Lithium Polymer, Lithium lon, Lithium Manganese and A123© chemistries. Adapt-
ers are available from FMA Direct.

m FEach cell is charged independently, providing exceptional charging safety and elevating RC
packs to the safety level of cellphones.

m Charges LiPo packs having one to four cells and any capacity up to 24Ah. Typical packs of
up to 3Ah capacity charge in 50 minutes or less using charger’s 1.4C Auto Current Mode.

m Multifunction display shows operating mode, individual cell voltages, charge current, supply
voltage, and amount of charge (mAh) put into pack. Plus, the unique Fuel display shows per-
cent capacity remaining in a pack.

m Viewer software (a free download) displays real-time data and graphs.

m Latest technology provides the ultimate in safety. Even charges packs having hidden physical
damage without danger of fire. A pack will not charge if individual cell voltages don’t equal
total pack voltage.

m Cell balancing to 10mV and automatic overcharge protection assure longest pack life. Auto-
matic temperature monitoring prevents pack overcharging at low ambient temperatures and
charger damage at high ambient temperatures.

m Low Voltage Restore feature automatically attempts to repair overdischarged packs. Cells
discharged as low as 0.5V may be repaired to as much as 98% of capacity.

m Cold Weather Charge stops charging at 4.10V/cell when temperature is below 55°F to prevent
cell damage.

m Operates from any 10-16V DC power source. Inputs and outputs are protected against re-
verse polarity.

Precautions

m Follow all instructions in this manual to assure safe operation.

m Always watch LiPo packs while they are charging. Never leave LiPo packs unsupervised dur-
ing charging.

m See additional warning sheets provided with this charger and FMA LiPo packs.

m Follow all guidelines for charging, discharging, handling and storing LiPo cells.
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Connecting the charger

Connecting packs with a Cellpro connector

Connect Cellpro Packs as shown in this diagram:

Mode
Optional connection to PC — . Butt
using FMA FSIM1 cable Lty utton s TR
LiPoorA123 | I lil-1e (g
Cell 4s Ch Pack (not used
ellpro 4s Charger during
«[E charging)

Connect to 10-16 VDC

(e.g., gel cell or power supply) Node Connector

CAUTION: When two LiPo packs are connected in series, do not connect them to two
separate chargers that are wired to a single power source. This sets up the dangerous
condition in which the series-connected packs are being charged in parallel (the power
source provides a common ground). One or both chargers, as well as the packs,
will be damaged. This condition will be avoided if the chargers are driven from two
unconnected power sources (e.g., two lead acid batteries). For safest charging of
series-connected packs, disconnect the packs from each other before connecting them
to chargers.

Connecting non-Cellpro packs

FMA Direct offers plug-and-play adapters for charging LiPo packs equipped with node con-
nectors made by other vendors. Check the Cellpro section at www.fmadirect.com for the lat-
est adapters.

If an adapter isn’t available for the pack you want to charge, or if the pack doesn’t have a
node connector, the FMA CPBP7 LiPo Pack Node Connector cable assembly will make the
pack compatible with the Cellpro 4s Charger. The diagrams below show how the Node Con-
nector attaches to packs of various configurations. Additional assembly information is pro-
vided with the Node Connector.

Red
r Pack positive
FMA CPBP7 LiPo Pack = Node 3
Node Connector — Node 2
M — Node 1
Pin 1 . Pack negative
Black
» 4s Pack . 3s Pack . 2s Pack
Pack positive Pack postive Pack postive
(red), 14.8v* 1% Coll 4 (red), 11.1V* (red), 7.4V*
Node 3, 11.1v* —] 3 .
. Cell 3 _ Cell 3
Node 2, 7.4V* i Node 2, 7.4V*i +
. Cell 2 _ Cell 2 _ Cell 2
Node 1, 3.7V* i Node 1, 3. 7V*i Node 1, 3. 7V"i
Pack negative T Cell 1 Pack negative T Cell 1 Pack negative T Cell 1
(blk), OV (blk), OV (blk), OV

* Nominal voltage with respect to pack negative.
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Charging modes

The Cellpro 4s Charger provides several charging modes. Please become familiar with them
before charging packs.

Normal charging modes

The Cellpro 4s Charger provides both automatically controlled and fixed charging current
modes:

m In 4.00A A123 3.60V Mode, cells are individually charged to 3.60V per cell. This is for
A123 brand of high current Lithium lon cells that handle charge rates up to 5C. Charge
current is fixed at 4.0A or the maximum charger output current.

Important: Only one mode is available for charging A123 packs. The 4.00A A123
3.60V Mode charges A123 chemistry to 3.6V per cell. Do not attempt to use any other
mode to charge A123 packs. Other modes will overcharge A123 packs to 4.2V per cell.

m [n 1.0C LiPo 4.20V Mode, LiPo/Li-lon cells are individually charged to 4.2V per cell.
The charger measures pack parameters and sets an optimal charge current.

m I[n 1.4C LiPo 4.20V Mode, LiPo/Li-lon cells are individually charged to 4.2V per cell.
Charge current is slightly higher than 1.0C LiPo 4.20V Mode. Packs smaller than 3Ah
will charge completely in about 50 minutes.

m In STORE LiPo @ 50% Mode, LiPo/Li-Ion cells are individually charged to 3.842V or
50% capacity. This is a good charge level for long term storage or shipping by mail.

m [n 0.25A thru 4.00A LiPo 4.20V Mode, LiPo/Li-Ion cells are individually charged at the
current you select. Charge voltage is 4.2V per cell.

When first connected to a power source, the charger is set for 3.00A A123 3.60V Mode (the
factory default). You can change to another current setting at any time by holding the Mode
Button. The charger remembers the charging mode and current setting when disconnected
from the power source, and will start in that configuration the next time it is used.

The 1.4C Auto Current rate is a breakthrough for LiPo charging. FMA has conducted exten-
sive testing at 1.4C with its cell-balancing chargers and compatible LiPo packs. No evidence
of safety issues or cycle life degradation has been found.

CAUTION: Only FMA balancing chargers can safely charge packs at 1.4C. Other char-
gers don’t charge individual cells, and are limited to a 1.0C rate. Charging at greater
than 1.0C with those chargers increases the risk of fire. Always follow charger and pack
manufacturers’ recommendations for maximum charge rate.

Other charging modes

m In Low Voltage Restore Mode, the charger automatically attempts to repair overdis-
charged packs. Cells discharged as low as 0.5V may be repaired to as much as 98% of
capacity.

m [n Safety Charging Mode, the charger detects that at least one cell is seriously out of bal-
ance, and automatically lowers charge current to 0.5A. To disable Safety Charging Mode,
disconnect the pack, then reconnect it.

CAUTION: When the charger’s display shows SAFETY CHARGING, the connected
pack is damaged. Treat damaged packs with caution. Do not charge them on a flam-
mable surface, and do not charge them unattended.

m In Cold Weather Balancing Mode, charging automatically stops at 4.10V/cell when tem-
perature is below 55°F to prevent cell damage.
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How to charge a pack

Tip: Because FMA's cell balancing technology monitors individual cells, you don’t need
to cool a pack before charging it. Go from flying to charging to flying again without wait-
ing. FMA cell-balancing chargers are the only ones that can charge a pack immediately
after discharge without damaging the pack.

1. Connect the charger to a power source and a pack as shown on the previous page.
2. If you want a different charging mode or current:

a. Press and hold the Mode Button. The display will cycle through available charging

modes and currents.

b. Release the Mode Button when the desired charging mode or current is displayed.

Tip: More information about the display—and how to navigate it—is provided on the
next page.

Note: You can change charger modes at any time, whether or not a battery is con-
nected to the charger. However, be careful. If you are charging an A123 pack (in 3.00A
A123 3.60V Mode, of course), you shouldn’t enter the menu (by pressing and holding
the Mode Button). Doing this could put the charger into a LiPo mode, which would over-
charge the pack. If you do change modes when a pack is connected, always make sure
the chemistry shown in the display (LiPo or A123) matches the connected pack.

3. Under normal conditions, the charger will beep at the following times:
m When pack has been charged to 90% of capacity.
m When pack has been charged to 100% of capacity.
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About the data display

The diagram below explains the data display, how to view data about the pack being charged, and
how to manually set the charge current.

Start

Connect charger
to power source

Note: In A123 Mode, "A123" will appear
where "LiPo" appears in these examples.

Connect pack
to charger

Available capacity (as a
Total pack voltage percent of total pack capacity)

|, Charger status:

Press
Mode Button

Individual cell voltages

To set specific charge mode
and current (at any time)

Press Press and hold
Capacity added to pack Mode Button Mode Button,
during this session then...

o
Charging current Press release
Mode Button Mode Button
<€ when desired
current appears
This line shows Charge current sequences from

Charge current Chemistry Charge Voltage 0.25A to 4.0A in 0.25A increments,
- - displays 1.0C, 2.0C, 3.0C, STORE
Tip: The charger stores the latest current setting. and A123 then repeats



Practical information about the Cellpro Charger

General information

Cells in a pack have different voltages when they are discharged. The Cellpro 4s Charger bal-
ances (equalizes) cell voltages while it is charging the pack.

During charging, cells that charge the fastest are the weakest cells in the pack. At the end of
charging, cells with the highest voltage are weakest. This happens because weaker cells have
lower capacity, and they charge faster than stronger cells.

If the Cellpro Charger displays LOW VOLT RESTORE, the pack was overdischarged during
its last use. The charger will attempt to repair LiPo cells measuring between 0.5V and 2.7V,
or A123 cells measuring 0V to 2.0V. To avoid additional damage to restored cells, do not
overdischarge a repaired pack.

By definition, end of life for a LiPo cell is when the cell can only be charged to 80% of its
original capacity rating. The number of charge/discharge cycles a cell undergoes before
reaching end of life depends on several factors, including cell quality, discharge rate, internal
heat generated during use, and other parameters. Cells in an older pack may be more out

of balance, but the Cellpro 4s Charger will still balance them to within 10mV by the end of
charge. For this reason, it may take longer to balance older packs. The charger may show
FUEL=99% for several hours while it is balancing a high capacity (3Ah and up) “veteran”
pack that is severely out of balance.

Charging packs

You can top off packs, or remove them when they are partially charged. There is no way to
damage a pack when using the Cellpro 4s Charger.

If a pack is at 80% or less of its capacity when connected to an auto-detect speed controller,
the controller may lower its cut-off voltage. This could overdischarge the pack during the
flight. Auto-detect speed controllers should properly set cut-off voltage if packs are charged
to at least 90%.

To save time, stop charging when the pack reaches about 95% of capacity. That last 5% takes
the longest.

Some cells may sag 0.10V within an hour after charging. This is normal as packs age.

When charging an A123 pack that has been discharged very low, the charger initially may
not be able to accurately count cells in the pack. To eliminate the possibility of an inaccurate
count, the charger applies current to “wake up” the cells, then recounts.

Overdischarging an A123 pack below 2.0V/cell will damage the cells (contrary to some re-
ports). The Cellpro 4s Charger requires a minimum pack voltage of 1.5V to activate charging.
If an A123 pack is below this voltage, do not try to repair the pack by boosting voltage. Even
if you manage to repair the pack, it will not have many cycles left and the charger will reject it
for multiple reasons (as indicated by displayed safety codes).

Storing packs

For best results, packs (except A123 packs) should be stored at 50% of capacity. Use the
charger’s Store Mode.

A123 packs can be stored at 100% of capacity (fully charged). In this chemistry, the break-
down voltage is higher than the fully-charged voltage.

CAUTION: Do not use the charger’s Store Mode for A123 packs. Store Mode applies
3.84V per cell, which will damage A123 cells.

Packs charged to 100% should not be cooled below room temperature. Cells at 90% or less
capacity can be cooled below 32°F (0°C).



How Auto Current Mode works

The Cellpro 4s Charger’s Auto Current Mode precisely monitors individual cell fuel levels
(cell voltages) in a pack. If the charger determines it is charging too fast, it slows down.
Likewise, if it is charging too slow, it speeds up. The charger adjusts charge current at one
minute intervals throughout the charge cycle.

When charging starts, it takes a short time for the charger to determine the correct parameters,
so it may “hunt” for up to five minutes before it settles on the optimum current. This is nor-
mal, and doesn’t harm the pack. The longer the charge, the more accurate the calculation.

The plot below shows how Auto Current Mode adjusts the charger’s current when charging a
1.25Ah pack at 1.0C. Initially, the charge current is higher than 1.0C. Within a few minutes
the charger adjusts the current downward, and it eventually reaches 1.0C (1.25A in this case).
Current drops as the pack reaches full charge. When charge current drops to about 0.1C, the
pack is fully charged.
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Since Auto Current Mode always starts at the last current calculated during the previous
charge cycle, the charger detects and adjusts for an overcurrent condition: if any cell’s volt-
age increases more than 10% during the first two minutes of charging, Auto Current Mode
defaults to 0.5A. This prevents overcurrent if the previously charged pack had a substantially
larger capacity.

With the 1.0C Auto Current Mode, a fully discharged pack is charged to its nominal capacity
in about one hour. Auto Current Mode takes into account a pack’s starting charge level, so
topping off a 50% discharged pack takes only about one-half hour.
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Estimating performance factors

If you don’t have a way to directly measure your propulsion system’s electrical parameters, the
Cellpro 4s Charger enables you to estimate them using before- and after-flight measurements.

1. Collect data
a. Charge pack.

b. When charging is finished, record Fuel % and total pack voltage (i.e. sum of cell volt-
ages).

c. Fly plane (or test on the ground). Record flight time in minutes.

d. Connect pack to charger. Record Fuel % and total pack voltage.

2. Calculate performance factors

(Fuel % before flight) — (Fuel % after flight)
100

x (Pack capacity, Ah) = Capacity consumed during flight, Ah
|

(Capacity consumed during flight, Ah) x 60
(Flight time, minutes)

= Average current during flight, A
|

\

Pack voltage before flight, V) + (Pack volt; fter flight, V. \

(Pack voltage before fig )2 (Pack voltage after fiig )=Average voltage during flight, V |
|

\

(Average power during flight, Watts)
(Model weight, pounds)

= Watts per pound

The “LiPo Performance Estimator” spreadsheet, which simplifies these calculations, can be
downloaded from www.fmadirect.com/tech_data/techdocs/.

3. Evaluate results

m Average current during flight gives you a rough idea whether system components—ESC,
motor, connectors and wiring—are operating within their current ratings. Keep in mind that
peak current during flight may greatly exceed the average current you calculated.

m Watts per pound is an approximate indicator of aircraft performance (other factors influenc-
ing performance include lift, drag and motor type). Here are some guidelines:

25 to 30 watts per pound: level flight.

40 to 50 watts per pound: take off from smooth surface, climb.

50 to 75 watts per pound: take off from grass, sport aerobatics.

75 to 125 watts per pound: pattern aerobatics.

Over 125 watts per pound: 3D.

Tip: For more direct electrical measurements, consider these FMA products:
m 60A Current Shunt (Model DVM-SHUNT-60)
m Digital Multimeter (Model DVM-VC890D)
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Charger Viewer Software

Installing the Charger Viewer Software

For detailed information on installing the Cellpro 4s Gold Charger Viewer Software, please go to
www.fimadirect.com/downloads.html, scroll down to the Software Updates section, then click the

link for the Cellpro 4s Gold Viewer Software.

Using the Charger Viewer Software

Use the Charger Viewer Software to monitor pack
voltage, cell voltages, charge current and safety codes
on your PC.

EM Yersion 1_04.TXT
File Wiew Help

Fast Charging Comm m

1. Connect the Charger to a pack and to a power Supply = 1216V [ s

supply. Cell 1= 4151V

Cell 2= 4160V

3. Connect the Charger to a PC using an FMA Cell 3= 4115V

FUIM2 or FUIM3 adapter. Plug the adapter’s Cell 4= 4.169V

3-pin connector into the jack on the Charger’s left Total= 16.58V

side. The black wire should be toward the top of

the Charger’s panel. AhrsIn = 0.015 An

Current = Auto/0.91A

4. On the PC, launch the Charger Viewer program.
The program checks ports until it finds charger
data, or open the Comm list and select a port.

m 7o add notes: View > Battery Notes.

m o see voltage versus time:
View > Graphs. Then in Graph window, View >

Fuel = 86 %

Charge Voltage or View > Discharge Voltage as
needed.
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450
o
400 ="
e
f
/’d"-

Charge Hours

o0 0.1 03 0.4 08 07 08 1.0 1.1 12

Tip: Resize the Graph window to see more detail.
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Updating the Charger’s Firmware

1.
2.

Disconnect any packs from the charger.

Connect the Charger to the PC using an FMA FUIM2 or FUIM3 adapter. Plug the adapter’s
3-pin connector into the jack on the Charger’s left side. The black wire should be toward the
top of the Charger’s panel.

Apply power to the charger.
On the PC, launch the Charger Viewer Software.

In the Charger Viewer, Help > Update Charger Firmware. The Firmware Update utility
opens in a new window.

In the Firmware Update utility:

a. Select the firmware version you want to install.

b. Click the Update Firmware button.

Wait—and do nothing to the PC, charger and interconnection—until updating is complete.
IMPORTANT: During firmware downloading, do not disconnect the charger from power,

do not disconnect the charger from the computer, and do not exit the firmware update
program.
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Troubleshooting

Operating errors appear as safety codes in the display. To determine the problem, look up the
code in the table below. Correct the error. If errors continue, contact FMA Customer Service.

Typical error message

Code Cause

1

Low-cell-voltage timeout on startup

Resolution

Try charging again no more than 2 times. Cell may
have internal short.

2 Input voltage below 10 volts Lower charge amps, get a bigger power source
(power source must output at least 5A).

3 Input voltage above 16 volts Power source voltage is too high. Lower voltage.

4 Input voltage unstable Power source is too small. Lower charge current.
Check for loose connections or thin wires.

5 Cell voltage above 4.30 volts Discharge pack.

6 Cell removed too many times Ensure red (pack +) wire is properly connected.
(charger attempted to charge, If error continues, pack or charger may have a
but failed) or red node wire not problem.
connected

7 Bad mode number Factory error. If error persists, send charger for

repair.

8 Checksum error Factory error. Send charger for repair.

9 Overcurrent Power source may be unstable. If power source

voltage is stable, send charger for repair.

13 Overvoltage shutdown Factory error. If error persists, send charger for

repair.

14 Bad EEPROM write Factory error. If error persists, send charger for

repair.

15 System soft start Check for bad power connection or low source

voltage.

16 Firmware corruption Factory error. If error persists, send charger for

repair.

17 Cell voltages don't total correctly Cycle charger power. Pack may have a bad cell.

Ensure red node wire is properly connected.

18 Cell balancing stopped after 8 hours  Raise charge current. Pack may be bad, or too big.

20 Fast charge stopped after 8 hours Raise charge current. Pack may be bad, or too big.

21 Bad cell count Check individual cell voltages (each cell must be

above 0.5V).

22 Charge current too low If pack is not full, try raising current above 1A.

23 Pack detect ran 8 times without Pack may have bad cell.
finishing a single charge Check individual voltages. If one cells is full and

another cell is empty, pack cannot be safely charged

24 Cell dropped below 3 volts during Pack may have bad cell.
charge

28 Pack detect failed Check individual cell voltages (each cell must be

above 0.5V). Ensure all node wires are properly
connected to cells, and black (pack —) node wire is
properly connected. Ensure battery ground is not
connected to power source ground. Charger may
be wet.

A123 pack drained to 0V may have damaged cell.
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Charger specifications

For battery type Lithium Polymer, Lithium lon, Lithium Manganese and A123 packs;
charger can be used with 1s to 4s packs having node connectors and
connected to charger with an appropriate FMA adapter cable

Pack capacity 250mAh to 20Ah (charge time limited to maximum of 8 hours)

Input voltage

10 to 16VDC, reverse polarity protected

Input current

Up to 6A at 10VDC, up to 4.5A at 13.6V

Power conversion

62.5kHz switcher operating at 90% efficiency

Nominal output voltage

4.20 volts per cell for all except A123 packs
3.60 volts per cell for A123 packs

Output current

Up to 4A, reverse polarity protected

Cell balancing

To within 10mV

Voltage calibration

Cell voltage measurements are factory calibrated to a standard
traceable to NIST; calibration is to t6mV

Current calibration

Charge current is factory calibrated on a 4A standard; calibration is to
+6mA

Measurement accuracy

Voltage: +10mV

Charge current: +1%
Capacity added to pack: +1%
Percent capacity (‘Fuel”): +5%

Serial data output

19.2kbps, 8 bits, 1 start bit, 1 stop bit, no parity

FMA limited warranty

Limits and exclusions

FMA technician.

FMA, Inc. warrants this product to be free of manufacturing defects for the term of one year from the date of pur-
chase. Should any defects covered by this warranty occur, the product shall be repaired or replaced with a unit of
equal performance by FMA or an authorized FMA service station.

This warranty may be enforced only by the original purchaser, who uses this product in its original condition as
purchased, in strict accordance with the product’s instructions. Units returned for warranty service to an FMA
service center will be accepted for service when shipped postpaid, with a copy of the original sales receipt or war-
ranty registration form, to the service station designated by FMA.

This warranty does not apply to:

= Consequential or incidental losses resulting from the use of this product.

= Damage resulting from accident, misuse, abuse, neglect, electrical surges, reversed polarity on connectors,
lightning or other acts of God.

= Damage from failure to follow instructions supplied with the product.

= Damage occurring during shipment of the product either to the customer or from the customer for service
(claims must be presented to the carrier).

= Damage resulting from repair, adjustment, or any alteration of the product by anyone other than an authorized

m |nstallation or removal charges, or damage caused by improper installation or removal.
Call (301) 668-7614 for more information about service and warranty repairs.
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